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Welcome!Welcome! 
Record any audio - three simple words to explain Audio Hijack Pro. Record from applications like iTunes,
Skype or DVD Player. Record from microphones, Radiosharks and other hardware. If you hear it, you
can record it.

New in Audio Hijack Pro 2.9.7New in Audio Hijack Pro 2.9.7
The Instant Hijack component has been updated to 2.2.7, which fixes several small bugs.
The LAME MP3 recording engine has been updated to 3.98.4.
The VoiceOver plugin now defaults to a lower buffer size, for reduced latency.
Several other small fixes have been made.

System RequirementsSystem Requirements
A Macintosh computer
Mac OS X 10.5 or higher

Installation And RemovalInstallation And Removal 
To install Audio Hijack Pro, just drag it from your download folder to your Applications folder, or
wherever you'd like to keep it. 

http://www.rogueamoeba.com/


To remove Audio Hijack Pro, simply place it in the Trash. If you've installed any of the extra
components, you may wish to uninstall them first using the Install Extras menu item in the Audio Hijack
Pro menu.

PurchasingPurchasing 
We provide a free trial of Audio Hijack Pro for you to test. In its trial state, noise is overlaid on all
hijackings longer than 10 minutes. The full version of Audio Hijack Pro can be unlocked with a license
key purchased from our online store. 

When you're ready, head over to http://www.rogueamoeba.com/store/ to purchase Audio Hijack Pro for
just $32, through our online store at: http://www.rogueamoeba.com/store/

ContactContact 
   Web: http://www.rogueamoeba.com/ 
   Support: http://www.rogueamoeba.com/support/ 
   E-Mail: audiohijackpro@rogueamoeba.com 
   Purchase: http://www.rogueamoeba.com/store/

 
Audio Hijack Pro is Copyright ©2003-2010, Rogue Amoeba Software, LLC

TutorialsTutorials
This section of the Help will aid you in getting started with Audio Hijack Pro. The easiest way to do this
is to give simple walkthroughs of how to use Audio Hijack Pro's basic features, so that's just what we've
done. Click on one of the sub-sections to the left to jump to your desired tutorial. 

Hijacking - The most basic operation in Audio Hijack Pro, hijacking simply allows AH Pro to control audio
from a source. 

Recording - Once a source is hijacked, you can record the audio from it. 

Effects - Once a source is hijacked, you can filter its audio using DSP Effect plugins. 

Timers - Not going to be around tonight? Tell Audio Hijack Pro what to hijack, what to do with the
audio, and when to do it. 

Recording A Stream - A tutorial featuring every step needed to record a streaming radio program with
Audio Hijack. 

Hijacking The RadioShark - Audio Hijack Pro can hijack and record from Griffin's RadioShark as well as
D-Link's DSB-R100. 

Hijacking System Audio - New in version 2.5, Audio Hijack Pro can now be used to grab all audio being
played through your Mac at one time.

How To Hijack AudioHow To Hijack Audio

Hijacking audio is the most basic operation in Audio Hijack Pro. When you hijack audio from a source,
the audio flows through Audio Hijack Pro, then back out to the designated output (generally, your
speakers). When audio is hijacked from a source, it can then be recorded for later listening or enhanced
using DSP effects, as detailed in later tutorials. 

Audio Hijack Pro can hijack from four different types of sources. Click below for help with: 
Hijacking An Application 
Hijacking An Audio Device 
Hijacking An AM/FM Radio 
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Hijacking System Audio

Hijacking An Application 
   Hijacking an application allows audio from a specific application, such as RealPlayer, to flow through
Audio Hijack Pro. This is the first step to recording or enhancing audio from one application. 

   Step 1) To begin, create a session in the Component list by clicking the + button. A session will now
appear with the name "(No application selected)" and be highlighted, ready for editing. 
   Step 2) In the Input tab, choose a target application in the Audio Source area. Click the "Select"
menu to see a list of all running applications and select the application you wish to hijack. If the desired
application isn't open, choose "Select Application..." and find it on your system. You may also drag and
drop an application to the Audio Source area. 
   Step 3) Once you have the application selected, just click the "Hijack" button. The "Hijack" button will
then illuminate and the Recording controls will be available. AH Pro now has control of the targeted
application's audio. 

   When targeting an application, you may wish to have it open a specific file. This file might be an
audio file such as an MP3, or it may be a bookmark for an internet radio station (see the Finding
Stream URLs page for more information on internet bookmarks). The "Open URL/File/AppleScript" field
allows you to pass off a specific URL location (by typing the URL or using an AppleScript) or file to the
target application set above. This is especially useful for timed recordings. When the session is hijacked
(either manually or automattically by a timer), AH Pro will launch the selected application and send it
the specified file, which the application should then begin playing.

Hijacking An Audio Device 
   Hijacking an Audio Device is useful for pulling audio from hardware such as record and tape players,
as well as microphones. 

   Step 1) To begin, create a session in the Component list by clicking the + button. A new session will
now appear, highlighted, with the name "(No Application Selected)". It's ready for editing. 
   Step 2) In the Input tab, adjust the Audio Source popup to "Audio Device", then set the desired
input device from which to pull audio. You may also adjust the Output device if you desire. By default,
the input will be played through the System's default output. Be careful to mute your speakers (with
the "Mute" button) or use headphones to avoid a feedback loop. 
   Step 3) Once you have the device set, just click the "Hijack" button. The "Hijack" button will then
illuminate and the Recording controls will be available. AH Pro now has control of the audio coming from
the Audio Device.

Hijacking An AM/FM Radio 
   Hijacking an AM/FM Radio allows for custom control of radios such as Griffin's RadioShark and D-
Link's DSB-R100, without additional software. 

   Step 1) To begin, create a session in the Component list by clicking the + button. A session called
"Untitled Session" will now appear and be highlighted, ready for editing. 
   Step 2) In the Input tab, adjust the Audio Source popup to "AM/FM Radio", then select the desired
radio device from which to pull audio. You may also adjust the Output device if you desire, and adjust
the frequency to which the radio is tuned. 
   Step 3) Once you have the radio set, just click the "Hijack" button. The "Hijack" button will then
illuminate and the Recording controls will be available. AH Pro now has control of the audio coming from
the radio.

Hijacking System Audio 
   Hijacking System Audio allows all audio played through Mac OS X to be controlled by Audio Hijack
Pro. 

   Step 1) To begin, create a session in the Component list by clicking the + button. A session called
"Untitled Session" will now appear and be highlighted, ready for editing. 
   Step 2) In the Input tab, adjust the Audio Source popup to "System Audio". 
   Step 3) When you're ready, click the "Hijack" button. The "Hijack" button will then illuminate and the
Recording controls will be available. AH Pro now has control of all audio on your computer.

How To Record With Audio Hijack ProHow To Record With Audio Hijack Pro
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Quick Overview

1. Open Audio Hijack Pro and hijack the desired session (See Hijacking for more information).
2. Open the Recording Tab of this session and adjust the settings as desired.
3. Click the Record button. If it lights and no error message appears in the status line, you are now

recording audio to the specified location on your hard drive!
4. Click Record again to end the recording. Load the file in your favorite audio player and enjoy!

   Once you have a session hijacked, you can easily record the audio coming from the source. You'll
want to adjust the Recordings tab to your desired settings, and then click the Record button. Once
Record is active, AH Pro will record all audio coming from the source. The Pause button will stop AH Pro
from recording the audio without creating a new file, useful for skipping portions of a program you don't
wish to save. The Split button seamlessly starts a new file, which is great for separating a recording into
tracks. Finally, clicking Record again ends the recording.

Adjusting Recording Settings 
   First, adjust the Format pulldown for the audio format in which you'd like to record. MP3 Low or AAC
Low will work for most spoken word audio, and MP3 High or AAC High will work for music. If you plan
to burn directly to CD, if you experience skipping or if you'd like a perfect, bit-by-bit copy of the audio,
use the AIFF setting. Be aware that this will create a very large file.

   After you've chosen your recording format, adjust the other settings as desired. These settings are
fairly straightforward - adjust the destination, the file name, and the post-processing script (if any). The
file name setting will allow you to use the Variables popup to name the recorded files. For example, the
example in the screenshot of "%n Recording (%d)" results in a file named "RealOne Recording
(20040728)".

   The Actions area allows you to have AH Pro take certain actions. You can have it start a new file
every so often (it will automatically split all files after 2 gigs), stop recording after a set amount of time
or disk space, and use the Silence Monitor to have silence removed from files or split when silence
occurs.

   Finally, the Tags section allows you to add information tags to MP3, AAC, ALAC and AIFF files.

How To Use DSP Effects With A HijackingHow To Use DSP Effects With A Hijacking
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Quick Overview

1. Open Audio Hijack Pro and hijack the desired application (See "Hijacking" for more information).
2. Click the Effects Tab. Click on a grid square and choose a DSP Plugin from the popup menu.
3. Edit the Plugins settings in the Editor window. Changes to audio take effect immediately.

   Digital Signal Processing (DSP) effects can be applied to any hijackings, including timed hijackings
(See "Using Timers"). DSP effects will be applied to both audio coming out the speakers and to a
recorded audio file. Setting up Effects is very simple, although some plugins themselves are rather
complex. The grid, seen above, is read in the order of the green wire, from left to right. When the wire
splits, effects are applied in parallel, and when they merge the audio is mixed and further plugins are
processed in series. Empty grid spaces are skipped, and plugins can be dragged and dropped around the
grid at any time to change their order. When using large numbers of plugins, the Navigator will be
helpful in moving about the grid. Just click anywhere on the Navigator to move to that location, or drag
the Navigator box around the map to move the focus of the grid. It shows the location of active plugins
in green and bypassed (inactive) plugins in black. 

For more information on specific effects, see the Effects Appendix

Inserting An Effect 
   To insert an effect, go to the Effects tab. You will see a portion of the DSP grid, as well as the grid
Navigator, Master Gain Slider, Dry/Wet Slider and Level meters on the left side. Simply click in the first
square of the grid and choose the desired effect from the pop-up menu. The plugin will be inserted into
the grid and its editor window will automatically open. Configure the plugin as desired and close the
editor. Now all audio played through AH Pro will be piped through this effect.

   On the plugin graphic itself, you will see two knobs, two buttons, and an information bar displaying
the indicator light and plugin name. The knobs affect the Gain of audio before it hits this filter ('In') and
after ('Out'). In most cases, you will want to leave them set at the mid-point. If you accidently move a
knob and wish to reset it, simply double click anywhere on the knob. The 'Editor' button brings up the
aforementioned editor window, allowing you to change the plugin's settings. The Bypass button leaves
the plugin and its settings intact, but causes AH Pro to skip over it. This is useful for testing exactly
how a particular filter is affecting the audio.

Removing An Effect 
   To remove a plugin, just click the arrows in that plugin's information bar and select None. Alternately,
you can highlight the plugin by clicking it and pressing the Delete key on your keyboard.

Installing Plugins 
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   AH Pro looks for VST plugins in "~/Library/Audio/Plug-ins/VST" and "/Library/Audio/Plug-ins/VST", for
AudioUnit plugins in "~/Library/Audio/Plug-ins/Components" and "/Library/Audio/Plug-ins/Components",
and for LADSPA plugins in "~/Library/Audio/Plug-ins/LADSPA" and "/Library/Audio/Plug-ins/LADSPA". To
install a new plugin, simply place it in one of these locations, and AH Pro will detect it on the next
launch.

How To Configure A TimerHow To Configure A Timer

Quick Overview

1. Open Audio Hijack Pro and set up the Session you wish to hijack in the Input Tab.
2. Create a Timer by clicking the + button under the Timers table. Set up the date or days and

time(s) when the Timer should run. If you wish to record, turn on the Record checkbox. If you
want AH Pro to mute output at the time of hijacking, turn on the Mute checkbox. If you want AH
Pro to quit the target application when the timer finishes, turn on the Quit Source checkbox.

3. Click the On checkbox in the Timers table, and check the Description column to be sure the Timer
is set correctly. Now when the set time arrives, Audio Hijack Pro will launch the source application
and pull audio from it.

   You can use a timer in an AH Pro Preset to hijack an application at a specified time and for a specified
interval. This can be useful for turning any application into an alarm clock, or for the timed recording of
Internet radio streams. You will set up a Session similar to how we did it in the "Hijacking" section. It is
likely you will wish to target a file, as most applications do not automatically begin playing audio when
launched.

Timed Recordings 
   Timed recordings allow you to use Audio Hijack Pro just like a VCR. You will most likely wish to record
an internet stream, so you'll need a bookmark file for that stream. These bookmark files tell the target
application exactly what stream to open. For more information on bookmark files and setting up Timed
Recordings, see the Finding Stream URLs page in the Advanced Topics section.

Creating An Alarm Clock 
   For a simple alarm clock, drag an audio file to the Audio Hijack Pro Source list - this will create a new
Session, targeting the appropriate application and that file. Once the AH Pro Target is properly set,
adjust the Timer controls. Create a new Timer by clicking the + button below the Timers table, then set
the date or day(s) it will run. Next, set the Start and End times for the hijacking. For a basic alarm
clock, just set the End Time an hour after the Start Time. You should now be all set and the Description
column should show when the Timer will fire.

Recording A StreamRecording A Stream
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   One of the most common uses for Audio Hijack Pro is recording streaming audio, particularly with
timed recording. We provide tutorials for Hijacking and Timers, but we'll outline the exact steps needed
to record a specific program. Here, we'll be recording the stream from KCRW, using RealPlayer. These
instructions can be adjusted slightly to record just about any streamed content, both archived and live.

   First things first, we need to launch Audio Hijack Pro. Once that's done, we'll create a new session by
clicking the [+] button at the bottom of the Components List. Then, in the Input pane on the right, we'll
set the Source Application to RealPlayer, which will be playing our audio stream.

   Next, we need to set the URL or file that the session will pass off to RealPlayer when it runs. In this
case, we'll be using the KCRW Live URL obtained from their website. We've now copied the URL that
Audio Hijack Pro needs (http://media.kcrw.com/live/kcrwlive.pls) to our clipboard. This is what we'll
paste into the Open URL/File field of our session. For full details on finding a stream's URL, see the
Finding Stream URLs page of the manual.

   As it's set now, when we click Hijack, the desired stream will be passed to RealPlayer, which will then
play the audio so we can record it. However, we'd like to use a timer here, so we don't need to be in
front of the machine to record. So, we need to create a timer in the Schedule area. We'll be recording
Cafe L.A., from 3 to 6 PM Eastern, on Sundays. We'll also turn on the Record, Mute, and Quit Source
checkboxes.

   Once that's set, we're done! Audio Hijack Pro will wake the machine at 3 PM, launch, and open up
RealPlayer to the specified stream. RealPlayer will play the stream, and Audio Hijack Pro will record it.
At 6 PM, the stream and hijacking will finish, RealPlayer will quit, and when we come back to the
machine, there will be a recording waiting for us in the Recording Bin. Now we can burn it to CD, drop it
on an iPod, or listen to it in iTunes.

Quick Review 
   Let's do a quick review of all that is necessary to record this stream in Audio Hijack Pro.

1. Open Audio Hijack Pro and set up a Session (see Hijacking), targeting RealPlayer as the source.
2. Enter the address of the stream you wish to record, (see Finding Stream URLs) in the Open

URL/File/AppleScript area.
3. Enable a timer in the Schedule area. Set up the days and times when the Timer should run, and

be sure to turn on the Record checkbox. You'll also likely want local output muted when the
recording is made, so turn on the Mute checkbox. That's it!

Working With The RadioSharkWorking With The RadioShark
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   The Griffin RadioShark is an AM/FM radio that attaches to your computer via USB. Once you have it
set up, you can play the radio through your Mac, and even record it. Many users wanted more powerful
recording options for the RadioShark, so Audio Hijack Pro now supports direct interaction with the
device. 

   Hijacking and recording from the RadioShark is quick and easy. The following instructions should get
you going. These will also apply to the D-Link DSB-R100, with a few minor adjustments. 

   Step 1) Create a new session, and set the source selector to AM/FM Radio. 
   Step 2) Select the RadioSHARK in the Radio Device area. You can also adjust the audio output, which
automatically uses the system's current default. 
   Step 3) Adjust the radio settings, including the band (AM or FM) and the frequency. Click Hijack, and
the audio will flow from the radio, through Audio Hijack Pro, and out your speakers.

Once you've got this set, you can create timers to record programs or just listen live. Create a session
for each radio frequency you use, and you can record dozens of AM or FM programs with Audio Hijack
Pro.

Hijacking System AudioHijacking System Audio
   New in Audio Hijack Pro 2.5 is the System Audio source. This enables Audio Hijack Pro to optionally
capture all audio coming through speakers, instead of just one application's audio. While capturing audio
on an application-level is recommended for most cases, capturing System Audio may be useful in some
instances. 

Initial Setup 
   The first time you use the System Audio component, you may need to install SoundFlower. To do this,
create a new session and set the source selector to System Audio. Now click the Install button in the
pane, and the SoundFlower installer will open. 
   Once SoundFlower is installed, the following steps will allow you to hijack and record System Audio. 

   Step 1) Create a new session, and set the source selector to System Audio. 
   Step 2) Click Hijack, and all audio will flow through Audio Hijack Pro, and then out your speakers.
That's it.

Once you've got this set, you can create adjust or record any and all audio on your machine.

Notes 
   Some applications have their own audio outputs. You'll need to set these to output to SoundFlower as
well, in order for AH Pro to pick it up. 
   Some applications will need to be relaunched to properly play their audio through the required output.
If audio isn't being pulled in through Audio Hijack Pro, first try relaunch the application playing the
audio.

PreferencesPreferences



Audio Hijack Pro's preferences are accessible from the Audio Hijack Pro menu or by pressing Command-,
on the keyboard. These preferences are fairly simple, and explained below. 

GeneralGeneral 
   Audio Editor - This adjusts to what application Audio Hijack Pro sends a file when the Editor button is
pressed in the Recording Bin. 
   Burning gap between tracks - This option sets the gap between tracks when burning a CD from the
Recording Bin. 
   Minimize To Menu Bar - When active on OS X 10.4, Audio Hijack Pro will be minimized to the Menu
Bar instead of the Dock. Option-clicking the minimize button reverses this behavior. 
   Automatically Check For Updates - Optionally turn off the version checking in Audio Hijack Pro. It's
recommended that this be left on. 

Quick RecordQuick Record 
   Hijack Hotkey - Once this Hotkey is set, pressing it will cause Audio Hijack Pro to hijack the
foreground application (using the Quick Record section). If it is already hijacked, Audio Hijack Pro will
release it. 
   Record Hotkey - Once this Hotkey is set, pressing it will hijack the foreground application and start
recording from it (using the Quick Record section). 
   Note: These hotkeys work best when using Instant Hijack (see the Install Extras window, accessible
from the Audio Hijack Pro menu). Without Instant Hijack, you'll need to relaunch the target application
when using the hotkeys.

Hidden FeaturesHidden Features
Audio Hijack Pro has a great many features, some of which can be a bit difficult to find. Read this over
for some of the lesser-known features of AH Pro.

ExtrasExtras 
We have several additional components for Audio Hijack Pro, available in the Extras window. To access
this window, choose Install Extras... from the Audio Hijack Pro menu.

Hijacking Multiple ApplicationsHijacking Multiple Applications 
Some users may not be aware that Audio Hijack Pro can hijack multiple applications at one time. This
enables you to hijack and record from, for example, RealPlayer and Safari at the same time. Two



separate files will be created, one for each application. All you need to do is hijack a second session,
just as you did with the first. The Input Tab controls are specific to each Session.

Hijacking Hidden ApplicationsHijacking Hidden Applications 
Audio Hijack Pro can target faceless applications, but they don't show up in the ordinary Source
Application selector menu. To view these hidden applications, hold down the option key as you press the
Select menu in the "Source" area

Variables In Recording TagsVariables In Recording Tags 
You may already know the "Name recordings with" field, as well as all the Tags fields, variables can be
used. A pop-up list appears in each field where variables may be used. For example, if you use the
%date variable in the Title, your recording's Title track will include 20050428. But in addition to the
variables including in the pop-up lists, all the variables found here are supported. To use these
variables, place "frmt_" in front of the variable. For example, instead of entering %a, type %frmt_a.
Enjoy!

Minimize BehaviorMinimize Behavior 
By default, Audio Hijack Pro will minimize to the Dock. By adjusting the Preferences, Audio Hijack Pro
can be made to minimize to the Menu Bar. To reverse the currently-set behavior, hold down option
when minimizing.

DebuggingDebugging

The Debugging dialog can be accessed by holding down the option key as Audio Hijack Pro launches. If
a problem occurs, these debugging options may show what's wrong.

Importing/Exporting SessionsImporting/Exporting Sessions 
Sessions are stored in a file called "SessionList.plist", located in the ~/Library/Application Support/Audio
Hijack Pro folder. This file can be placed in the same location on a new machine to retain the same
Sessions.

Little ThingsLittle Things 
-Timers do not have second-precision, and can only be set for hours and minutes. However, if you edit
the From or To fields and tack on a colon and seconds (01:00:30 PM, for instance), Audio Hijack Pro
will run the timer as close to this as possible. 

-The Punch buttons on the master effects controls (Mute and Full in the Master Gain window, for
instance) can be used to do A/B comparisons. Shift-clicking and holding will snap the slider to whichever

http://developer.apple.com/documentation/Cocoa/Conceptual/DataFormatting/Articles/df100103.html#//apple_ref/doc/uid/TP40007972-SW14


end is being pressed, and releasing will return it to its original position.

Hidden PreferencesHidden Preferences

In the name of simplicity, not all of Audio Hijack Pro's preferences are accessible from within the
application. Some prefs can only be accessed through the "defaults" system in the Terminal or by
editing the preferences file (~/Library/Preferences/com.rogueamoeba.AudioHijackPro.plist) by hand. 

registrationObscured: This preference controls the visibility of the registration code in the Registration
window. If you're in a group environment, you may wish to obscure this code to prevent theft. 

The example command below for the Terminal will cause the code to be obscured in the Registration
window. 
defaults write com.rogueamoeba.AudioHijackPro2 registrationObscured YES 

AHKitShouldPermitDisplaySleep: This preference enables the display to sleep while recording.
Because display sleep (and waking) can cause skips in recordings, this is off by default. 

The example command below for the Terminal will enable display sleep while recording. 
defaults write com.rogueamoeba.AudioHijackPro2 AHKitShouldPermitDisplaySleep -bool YES 

DisablePowerOn: By default, when Schedule Helper is installed (see the Install Extras window), the
machine will automatically power on to run timers. Automatic login will need to be turned on for this to
work properly. If desired, this functionality can be turned off. Log out will be required after updating this
for the change to take effect. 

The example command below for the Terminal will prevent the machine from powering on to run timers.
defaults write com.rogueamoeba.ScheduleHelper DisablePowerOn -bool YES 

DisableWake: By default, when Schedule Helper is installed (see the Install Extras window), the
machine will automatically wake from sleep to run timers. This is recommended, but if desired, this
functionality can be turned off. Log out will be required after updating this for the change to take effect.

The example command below for the Terminal will prevent the machine from waking up to run timers. 
defaults write com.rogueamoeba.ScheduleHelper DisableWake -bool YES

Known Issues In Audio Hijack ProKnown Issues In Audio Hijack Pro
Audio Hijack Pro goes through rigorous design and testing before it every gets released. However, there
sometimes arise issues which can't or won't be worked around, at least not presently. Read on for more
information. 

AirPort Express And iTunes: Audio Hijack Pro can not hijack audio from iTunes while iTunes is sending
audio out to an AirPort Express. To properly hijack iTunes, you must use the Computer output option. 

Fast User Switching: Because audio playback can behave in unexpected ways when switched out of an
account, Audio Hijack Pro is not supported for use with Fast User Switching. 

Effect Editor Windows: Due to conflicts between Cocoa and Carbon, neither Command-W nor Close
Window will work on DSP Editor windows. The red 'Close' button must be used.

Purchasing Audio Hijack ProPurchasing Audio Hijack Pro
Quick Link: To buy a license key for Audio Hijack Pro, visit our online store.

Why should I buy Audio Hijack Pro?Why should I buy Audio Hijack Pro? 
Put simply, you should buy Audio Hijack Pro because it isn't free - we give you a chance to test out the
program and all its features before you buy it. It's like test driving a car, for as long as it takes you to
decide. 

In trial mode, all of Audio Hijack Pro's features are available to try, but it won't work for full-time use.
Until you purchase, noise will be overlaid on all audio Audio Hijack Pro pulls in after ten minutes. 

If you use Audio Hijack Pro and find you like it, please purchase a license key and support Rogue
Amoeba. You'll be allowing us to continue to bring some of the world's best software products into

http://www.rogueamoeba.com/store


existence.

What does Audio Hijack Pro cost and where do I buy it?What does Audio Hijack Pro cost and where do I buy it? 
Audio Hijack Pro is available for purchase the world over for just $32. To purchase your license key,
just visit http://www.rogueamoeba.com/store/.

What types of licenses do you offer?

We have two types of licenses, Single-user and Family Pack. 

• Single-user licenses are for a single user on one or more personal machines. 
• Family Packs are for up to five users in a single household, on one or more personal machines. 
• Family Packs are not valid for use by businesses. Businesses and organizations can save with our
volume discounts, available automatically with quantities of 10 or more.

After PurchaseAfter Purchase

How does purchasing work?How does purchasing work? 
When you purchase through our store, you'll immediately receive a license key in your browser, as well
as via email. This key will allow you to unlock the full version of Audio Hijack Pro. Simply enter your
key into Audio Hijack Pro as instructed, and you'll be all set.

Can I use my license key on multiple machines?Can I use my license key on multiple machines? 
A license key for Audio Hijack Pro provides 1 "seat". This allows for a single copy to be in use at one
time. If you own multiple personal machines, you may install and unlock Audio Hijack Pro on them,
provided it is only in use on one machine at a time. If you need to use Audio Hijack Pro simultaneously
on multiple machines, you'll need to purchase multiple license keys.

What's your upgrade policy?What's your upgrade policy? 
Rogue Amoeba doesn't have a stated upgrade policy, just a great track record. Since 2002, we've
provided hundreds of free updates across our entire product line. These updates have fixed bugs and
added new features. If we add substantial new functionality, we may charge an upgrade fee. However,
we do not make most of our income from upgrades, and we provide nearly all updates free of charge.
Buy with confidence!

What's your refund policy?What's your refund policy? 
All Rogue Amoeba products are available as demos for an evaluation prior to purchase. We believe that
no customer should have to buy software in order to find out how well it works. Our software can be
fully evaluated with no limitations in capabilities, prior to purchase. Customers are strongly
encouraged to take advantage of these trials prior to purchase. You may also seek any needed
technical support from us - we answer support emails rapidly and responsively for current and potential
customers alike. 

If you would like a refund, please contact hello@rogueamoeba.com within 14 days of your purchase.
Because we can not recover the license key that was sold, refunds are issued on a case-by-case basis.

Cross-PromotionCross-Promotion

http://www.rogueamoeba.com/store/
http://file:///Users/pxr/Downloads/Audio%20Hijack%20Pro.app/Contents/Resources/Audio%20Hijack%20Pro%20Manual.helpbundle/Contents/Resources/English.lproj/hello@rogueamoeba.com


 
Fission

Editing Audio With FissionEditing Audio With Fission 
After you've made a recording with Audio Hijack Pro, you may wish to edit it. With Fission, you can edit
any audio recorded with Audio Hijack Pro. Edit files losslessly, trim out commercials, normalize volume,
and more, with Fission!

Bundle UpBundle Up 
Fission costs just $32. Better still, you can purchase Audio Hijack Pro and Fission together as a bundle,
for just $50!

So how do I buy Audio Hijack Pro?So how do I buy Audio Hijack Pro? 
To purchase a license key for Audio Hijack Pro, just visit http://www.rogueamoeba.com/store/ and
follow the instructions there.

Advanced TopicsAdvanced Topics
   The following pages will assist you with many common questions and problems. If you have an issue,
read over the relevant article for more information on the topic. If none of the Advanced Topics articles
address your problem or question, please (please!) email us for support. Send mail to
audiohijackpro@rogueamoeba.com, and we'll work to get your issue solved.

TroubleshootingTroubleshooting
   This page will assist you with troubleshooting any problems you're having with Audio Hijack Pro.
Follow the steps in this troubleshooting guide and your problem may disappear. After each step, test
Audio Hijack Pro again. If you reach the last step, and it's still not working, then please contact us via
email.

Update 
   Be sure you're using the latest version of Audio Hijack Pro. Check by using the 'Check For Update'
command in the Audio Hijack Pro menu.

Exclude Applications (Instant Hijack Only) 
   If you're using the Instant Hijack component, and you're experiencing problems with specific
applications, you can try excluding them. AH Pro will not affect any excluded applications. To exclude an
application, open the System Preferences and go to the APE Manager. Click Instant Hijack Server and
add the application to the Exclude List. Once you restart the application, AH Pro will no longer be
affecting it at all, and you can be certain any problems you're experiencing aren't related to it.

Delete Preferences 
   Try the old OS 9 standby of deleting the application's preferences. On your OS X hard drive, go to
your Home folder and open Library/Preferences (~/Library/Preferences) and delete the file
"com.rogueamoeba.AudiohHjackPro2.plist". As well, go to your Home folder and open Library/Application
Support, and remove the "Audio Hijack Pro 2" folder.

Check for a messages from Audio Hijack Pro 
   Did Audio Hijack Pro give you any error messages? If so, pay attention to them! These error
messages are designed to tell you something is wrong, and to help us diagnose the problem if you can't
fix it. You may also see error messages if you check Console.app (located in
/Applications/Utilities/Console).

If all else fails... 
   If these steps haven't fixed your problem, please (please!) email us for support. Send mail to
audiohijackpro@rogueamoeba.com, and we'll try to get your issue solved.

Finding Stream URLs For Use With TimersFinding Stream URLs For Use With Timers

http://www.rogueamoeba.com/fission/
http://www.rogueamoeba.com/store/
mailto:audiohijackpro@rogueamoeba.com
mailto:audiohijackpro@rogueamoeba.com


   In order to create effective timers in Audio Hijack Pro, it's best to have a direct link to the URL of the
stream you wish to record. Just like you need to tell your VCR what channel to record, Audio Hijack Pro
needs to know what stream to pass off to the source. The proper URL is entered in the Open URL field,
and the selected source application opens this URL at the appointed time. The key is ALWAYS to have
the exact address of the stream.

   However, finding these URLs can be tricky. There's no single correct way to find the URL for a stream,
but we've outlined several methods to try. Generally, at least one of these methods will provide a direct
link to the stream. When you have a bookmark file or direct URL, choose the proper application in the
Application selector of a Session, then use the "Select" menu under the "Open URL/File/AppleScript"
field, and choose "Select File..." to pick the proper bookmark, or just paste the URL in. When you hit
"Hijack", Audio Hijack Pro will send the link on to the source application.

Click The Listen Button 
   When accessing a stream's website, there is often a "Click To Listen" button or link, or something
close. This is used to open the stream, for live listening. However, it often downloads a bookmark file,
which will usually end in one of the following file name extensions: .ram, .asf, .rm, .smil, .mov. Other
bookmark types may also be found, these are just some of the most common. When double-clicked,
this file will usually lead directly to the stream you're tuned in to. You can use this file in the Open URL
field.* 

   Also, take note that many streams play inside of your web browser (using browser plugins). However,
they often have an option to "Listen In Stand-Alone Player" or a link to click if you're having listening
problems. This too will often download the bookmark file you need.

Control-click The Listen Button 
   Instead of simply clicking the Listen button, try control-clicking it. This will bring up a menu with
several options, and you can use the "Copy Link To Clipboard" option to pull the link out. You can then
paste this link into the Open URL field of your session. Be sure to test this link, however, it won't always
be the direct stream link for which you're searching. When it is, however, you'll be all set.

Search The HTML 
   Sometimes, it can be difficult to locate a link. If you're up to it, you can try scouring the HTML code
that defines a web page. Choose View Source from Safari's View menu, and try to hunt down the
stream's URL. These will often end in .rm, .ram, or .asx.

Check The Player 
   If you can't find the URL, but you can get it to play in a stand-alone player such as Windows Media
Player or RealPlayer, you can often find the URL by checking the Player's Info window. This window,
called Get Info in Window Media Player and Clip Info in RealPlayer, provides information on the current
stream. This should include a direct link to the stream which you can copy and paste out.

Dynamically Create URLs 
   With AppleScripts, you can use Audio Hijack Pro to dynamically generate stream urls, grabbing urls off
the web that change often. This is especially useful for stream urls that change based on dates. Look at
the following script example:

set urlString to "http://example.com/path/to/show/%Y-%m-%d.ram" set urlString to do shell script
"echo -n;date '+" & urlString & "'" return urlString

   If the date is July 28th, 2004, this script will returns the url: http://example.com/path/to/show/2004-
07-28.ram. Create a script with similar code, then use the "Select" menu under the "Open
URL/File/AppleScript" field, and choose "Select AppleScript..." to pick the proper AppleScript. When you
hit "Hijack", this script will run and return the address, which will then be passed on to the source
application.

Worst Case, Leave The Stream Running 
   If all else fails, you can simply leave the stream running. Set it up for live listening. Then, create a
new Session, set the proper audio source, and set a timer. You can even pre-hijack the application, and
use AH Pro's Mute button to mute local output, though this isn't required. Then, when the timer runs, it
will record the already playing stream. Note, this works best with the Instant Hijack component
installed, so see the Install Extras menu item under the Audio Hijack Pro menu.

   Good luck, and happy recording!

*Be aware, RealPlayer will often delete these files once it opens a stream, in a misguided effort to keep your hard drive
clean. To prevent this, lock the file in the Finder. Get Info on the bookmark file, and turn on the Locked checkbox, and
RealPlayer will be unable to delete the file.



Importing Records,  Cassettes,  And MoreImporting Records,  Cassettes,  And More
   Many people want to bring records, cassette tapes, and other types of audio, into their computers and
save them as MP3 or AAC files for later listening. Audio Hijack Pro is very useful for doing this, and
we've outlined the steps for doing it here. With these instructions, you can important any audio into
your computer.

   First, you need to get the output of the audio device (your stereo, a microphone, etc.) into your Mac.
Fortunately, almost all Macs have a Line Input port.* In most cases, you'll need a stereo mini-jack
(1/8") patch cable coupled with a 1/8" to 1/4" adapter, like these from Radio Shack. No matter where
you go, total cost to get the audio from your stereo to your computer should be under $10. Once you
have the cables, just plug one end into the output of your stereo (the headphone jack works nicely) and
the other into your computer's Audio In port.

   Once you've done this, open up Audio Hijack Pro. Make a new Session, and set the Source Type
selector, in the Input tab, to Audio Device. Select the proper audio device from the Select menu on the
right - in most cases, this will be "Built-in Audio: Line In". Finally, adjust the Recording tab as desired,
setting the file type and entering the desired tags.

   Now you're ready to hijack and record. Click the Hijack button, and press Record. Then, start the
audio playing from your source, and it will be recorded. That's about all there is to it. When you're
done, turn the hijacking off, and disconnect the input device.

Assorted Notes: 

-For recording audio off a record or cassette, using the Split button will seamlessly create a new audio
file each time you hit it. Hit it in between tracks, and you'll wind up with different files for each song.
You can also try using the Silence Monitor in the Recording tab to automatically split between tracks.
Try the Analog preset to start, or experiment with a Custom setup. 

-Many people also want to remove noise on the signal. As you may know, AH Pro supports VST and AU
plugins in the Effects tab. With the low pass filter, you may be able to remove some hiss from
cassettes. Other plugins such as Excitifier may allow you to improve audio fidelity. Experimenting o your
taste will likely enable you to get the results desired. 

However, if you're planning to do a lot of audio importation, you may wish to invest in a more
professional solution. Check out Bias Inc's SoundSoap VST plugin. It'll plug right in to AH Pro and clean
up all kinds of artifacts. It's not cheap at $99, but it will almost certainly serve your purpose.

*If your Mac doesn't have an audio input jack, you can use Griffin's iMic to gain an audio input.

Preventing Skipping/Saving CPUPreventing Skipping/Saving CPU
   When recording, Audio Hijack Pro's recording status line (found under the Record button) may indicate
that skipping has occurred, as seen in this image: 

On most machines made in the past 4 years, Audio Hijack Pro should be able to run just fine with no
skips. However, on older machines, you might find that recordings contain skips. This can occur for
several reasons and we've outlined steps to prevent it below.

Use The Root Hard Drive 
   We've seen problems with skips when people record to an external firewire drive. From a technical
standpoint, this should be no problem, as firewire is plenty fast. Nevertheless, switching the destination
to the root hard drive (the one on which your System is installed) may clear up skipping.

Save CPU 
   The other thing you can do is reduce the amount of CPU Audio Hijack Pro needs, and increase the
amount of available CPU. More details are outlined below. 

   1) Quit processor-intensive applications: OS X allows many applications to run at once. However,

http://www.radioshack.com/product/index.jsp?productId=2102950
http://www.radioshack.com/product/index.jsp?productId=2062468
http://www.bias-inc.com/
http://www.griffintechnology.com/products/imic2/


some applications take up a lot of CPU, such as iTunes. If you don't have to have these applications
open for the recording, quitting them may help. 

   2) Switch To Custom MP3: In the Recording Format menu, choose the Custom... Set this to MP3, CBR,
Stereo, the desired bitrate. Then, turn the Quality slider down. 

   3) Switch to a lower bitrate MP3: The lower the bitrate set for encoding, the less CPU will be used. 

   4) Switch to another format: AAC encodes faster than many MP3 types, so this may result in fewer
skips. Even faster is ALAC, and finally AIFF. AIFF is the absolute fastest way to record, using the least
CPU, and you can easily post-process it to MP3, AAC, or ALAC right from the Recording Bin. 

   5) Turn off Effects: Effects in the Patch area use CPU to do their processing. Turning these off (by
highlighting and pressing the Delete key, or by choosing None from their Title menus) will conserve
some processor power. 

   6) Turn off Level Meters: Level Meters use a small amount of CPU power. Turn off the Levels in the
Effects tab by clicking the bar that indicates their type ("In Peak", for example). The level meters in the
control area can also be turned off, by Control-clicking and choosing Off.

If all else fails... 
   If these steps haven't fixed your problem, please (please!) email us for support and include
information on your system. Send mail to audiohijackpro@rogueamoeba.com, and we'll try to get your
issue solved.

Recording Audio From A DVDRecording Audio From A DVD
From ABBA to Zeppelin, more and more bands are putting out concert DVDs. That's great, but it's not
possible to listen to the music on these DVDs away from a DVD player. Until now, that is - Audio Hijack
Pro is great for taking audio off concert DVDs ( or any type of DVD) and letting you use it as you like.
This works just like any other hijacking, but people ask about it enough that we've made an exact set
of directions for doing it. Follow along, and you can listen to the audio from your concert DVDs with
your iPod, or burn it to a CD and take it in the car.

Set Up

For our example. we'll be using DVD Player. Alternative DVD players such as VLC should also work fine. 

1) Launch Audio Hijack Pro and create a new Session. 
2) Set the Input tab of the Session to Application, then slect the DVD Player application (found in the
Applications folder). 
3) Now, adjust the settings in the Recording tab. If you plan to burn this audio to a CD and deleting the
copies from your hard drive, save the files as AIFF (Auto) to get perfect quality audio. If you'll be saving
these files to listen to in iTunes or on an iPod, record to MP3 or AAC. 
4) Finally, click Record and play the DVD in DVD Player. Any audio played in DVD Player will play
through Audio Hijack Pro and be recorded. If you're recording a full concert DVD, press the Split button
in-between tracks to get multiple files, one for each song.

When you're done, be sure to hit Record again to end recording of the last file. Your files will be saved
to the specified location, as well as accessible from the Recording Bin. From here, you can send the files
to iTunes, right to an iPod, or burn them to CD. Now you can enjoy audio from DVDs anywhere you
like!

mailto:audiohijackpro@rogueamoeba.com


Recording Voice ChatRecording Voice Chat
With the introduction of version 2.7 and the new (largely invisible) MegaMix mode, recording audio from
voice chat applications such as Skype and iChat is now much, much simpler. As of version 2.7, the
following is all that's needed to hijack from Skype, iChat, and Gizmo Project. We'll use Skype in our
example. 

 

1) Create a session and set Skype as the audio source, in the Input tab. 

2) Click Record, and have your conversation in Skype. 

That's it! Now all audio from Skype will be recorded by Audio Hijack Pro, just as it should be. Audio
Hijack Pro automatically uses MegaMix mode for all new sessions where the source is Skype, iChat, and
Gizmo Project. it can also be activated manually for other applications in the Advanced Hijacking
options, by clicking the Advanced... button. 

Note: If you wish to separate your audio onto one channel and the other party's audio on the other
channel, turn on this option in the Advanced Hijacking options, by clicking the Advanced... button.

Recording A PodcastRecording A Podcast

What is it? 
A podcast is simply a recorded file, available on-demand for listeners to grab, and listen to at their
leisure (often on an iPod). Thousands of people all over the world are creating podcasts, from celebrities
to your next-door neighbor, on every topic imaginable. If you want to create a podcast of your own,
Audio Hijack Pro will help get it done.

The Most Basic Podcast: A Man And His Mic 
The most basic podcast consists of one host talking, with nothing else. The setup for this is as basic as
the show itself. Follow the steps below to set this up.

Basic Set Up 
1) Launch Audio Hijack Pro and create a new session. 
2) Select Audio Device in the first popup menu of the Input tab. 
3) Set the Input Device to the appropriate device, your microphone. You'll also want to set an Output
Device, either a pair of headphones (to avoid feedback) plugged in to the Built-In Output or Silence
Output. 
4) Now, adjust the settings in the Recording tab as you desire. For a talk program, an MP3 file of 64
kbps (MP3 Low) will sound great. You'll probably also want to edit the Tags section for your show - this
information will be visible to listeners once they download the file and play it in their MP3 player.

Once you've got Audio Hijack Pro set as above, you're ready to go. Click the Hijack button, and then
click Record and talk away. Everything you say will be recorded and if you need to, you can pause the
recording by clicking Pause. When you're done, click Record again to finish the recording. 



Click to hear a basic podcast recording

Adding In Music and/or Sound Effects 
Once you've mastered a basic podcast, you may wish to improve it by interspersing music or sound
effects. You can play songs during your podcast, insert pre-recorded interviews, or just drop in sound
effects - Audio Hijack Pro makes all this easy and fun. 

To start, you'll want to set everything up as above, then move over to the Effects tab of your session.
Insert the Application Mixer plugin by clicking a cell ("Click here to insert effect") and choosing it from
the 4FX section. Select the Application from which you wish to pull audio, probably iTunes or QuickTime
Player.

The Application Mixer plugin

Now you'll want to queue up audio in your source. Create an iTunes playlist for your music or open up
windows in QuickTime for each sound effect you want to drop in. Click the Hijack button inside
Application Mixer, and audio from your input device (your microphone) will be mixed evenly (by default)
with the source selected in Application Mixer.

You can also adjust the Crossfade slider as desired. If you want the AppMixer source to be the only
audio source while it plays, use the crossfade buttons (  and ) to fade to the Application side as you
start a song. When the song ends, click the Source arrow to fade back. If you're using sound effects,
just leave the crossfader at the default position. When you're done inserting audio, click AppMixer's
Release button and resume talking with the microphone.

Click to hear a more complex podcast recording

[Note: On OS X 10.4, you can alternately use the AUAudioFilePlayer plugin, detailed in a previous post. This plugin allows
for all audio to be self-contained in one application (Audio Hijack Pro), but at the time of this writing, almost 70% of users
are still on Panther (OS X 10.3). If you're interested and you're running OS X 10.4 (Tiger), play with AUAudioFilePlayer and
see if you like it more than Application Mixer. Otherwise, just follow the instructions above.]

Chat It Up

The other major way in which Audio Hijack Pro enables you to create rich podcasts is by allowing you to
pull in audio from a voice chat client, such as Skype or iChat. By grabbing audio from a Skype
conversation (we'll use Skype for our example, but this all applies to iChat as well) as well as your own
mic, Audio Hijack Pro enables you to record live interviews or conversations with remote users right into
your podcast.

http://file:///Users/pxr/Downloads/Audio%20Hijack%20Pro.app/Contents/Resources/Audio%20Hijack%20Pro%20Manual.helpbundle/Contents/Resources/audiofiles/ABasicPodcastRecording.mp3
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Once again, you'll want to set up Audio Hijack Pro as above, to pull audio from your microphone. You
need to make sure that Skype uses the same audio input you're pulling from in Audio Hijack Pro. You
can adjust this in Skype's preferences window.

Start hijacking your session in Audio Hijack Pro, then set up the Application Mixer plugin in the Effects
window by clicking a cell ("Click here to insert effect") and choosing it from the 4FX section. Select
Skype in the Application area, and leave the Crossfade in the default. Once you click the Hijack button
in the AppMixer plugin, both halves of any Skype conversation will flow through Audio Hijack Pro.

You can now initiate a conversation in Skype, and record it as part of your podcast. While conversing,
you'll want the crossfade slider at the halfway point, but when you setup the call you may wish to leave
it at Source (or leave AppMixer's source unhijacked) to avoid including the various sound effects. Set up
your call, talk to the other party, then Release AppMixer's source when your done. When you're finished
with the entire podcast, end the full session hijacking, and you're all set.

Click to hear a podcast recording with chat
Share It With The World

That's really all there is to it, as far as the creation of the audio goes. Once you've got your podcast
recording done in Audio Hijack Pro, you may wish to edit it in an audio editor, or it may be perfect
already. Either way, you'll definitely need to upload your file to a web server and create an RSS feed for
it.

With RSS 2.0, you can include an enclosure (just like email) in the feed, so that subscribers will
automatically download the audio file when the RSS feed updates. The Enclosure tag details where the
file is located on the web. Here's what it looks:

<enclosure
url="http://www.rogueamoeba.com/utm/content/files/2005
0520podcastcreation/ABasicPodcastRecording.mp3"
length="30016" type="audio/mpeg"/>

Our Test Feed

You can download our test RSS feed to take a look at. Once your own feed is created, you can test it
with this validator. Put the RSS file online and link to it, and your listeners will be able to tune in.

It's Your Turn Now

That's a full wrap-up - now it's time to make your own podcasts. With these instructions, you'll be able
to make rich, full podcasts that sound great. Your listeners are waiting!

Recording OptionsRecording Options
   With Audio Hijack Pro, you can record audio to four different formats - AIFF, ALAC (Apple Lossless),
MP3 and AAC. Each of these four formats also has many sub-options, and we've detailed many of the
various recording options below. First, let's examine what format is right for you.

Which Format Is Right For Me? 
   There are a lot of audio formats and options in AH Pro. If you don't know what you're looking for, a
safe bet is to record to MP3 or AAC. Both of these compressed audio formats result in medium to high
quality files and use low amounts of disk space. So, what bitrate do you need? If you're recording
spoken word, a very low bitrate will still sound great. If you're recording music, 128 or 192 kbps is a
good place to start. Just remember, as you lower the bitrate, you lower both the quality and the
amount of disk space being used up by the file. Experiment and find what the best tradeoff is for you. 

If you're burning to a CD or planning to edit the file before you use it, save to AIFF. If you want a
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perfect quality copy but don't want to use all the disk space of AIFF, use Apple Lossless - it's
compressed, but it's an exact copy of the audio as it was received.

Bulletproof MP3 And AIFF Recording 
   On OS X, applications crash a lot less often than they used to. But bugs and kernel panics still
happen, and if you're in the middle of a recording, this can be a huge setback. With Bulletproof MP3 and
AIFF recording, Audio Hijack Pro constantly updates the saved recording, so if you have a crash, you
won't lose any of the previously recorded audio. All MP3 and AIFF recordings are bulletproof, so just
choose an MP3 or AIFF format to use this feature.

CBR vs. VBR vs. ABR 
   MP3 recording has 3 different sub-formats. CBR will work in any MP3 player but is a bit inefficient,
while VBR and ABR offer a bit more in the way of overall performance, but may have problems in some
older mp3 players. In short: 

   CBR (Constant Bit Rate): The amount of disk space per second of audio is set prior to recording and
used for the entire file, regardless of how complicated parts of the audio are. Thus, some portions get
less space than they need, and others get more than they need. Compared to the other formats, it's
less efficient, but it uses the least CPU and is universally recognized. 

   VBR (Variable Bit Rate): Each portion of audio is given the amount of disk space it needs, within a set
boundary. This will give the best sound quality of the three, but some software won't recognize it or
play it properly. 

   ABR (Average Bit Rate): The disk space used is an average of what's needed for the entire file, so the
portions which need a lot of space will get more and those that don't will get less. This is the least
universal format, but it's a good technical compromise between CBR and VBR. 

For more info, see http://lame.sourceforge.net/doc/html/modes.html

MP3 Quality Sliders 
   Custom MP3 Formats use one or both of the Quality sliders seen in the Custom sheet. The higher the
quality, the better the audio file will sound, all without using more disk space. The tradeoff here is that
it will use more CPU power in encoding. VBR will also use the VBR Quality slider. The higher this is set,
the more the file will fluctuate from the chosen bitrate. This means that portions of audio that need
more disk space are more likely to get it. Again, this requires more CPU.

Lossy vs. Lossless 
   When doing audio encoding, the goal is to save space over the raw audio. MP3 and AAC are very
good at this, reducing file size down to about 10% of the original audio. However, these are "lossy"
formats - when you record to them, some of the original audio data is lost. Often, this goes unnoticed,
but if you hear artifacts in the audio or if you need perfect quality recordings, consider AIFF or ALAC -
these formats are both "lossless", meaning all the original audio data is there. In the case of AIFF, the
file size is not compressed at all. ALAC uses about half as much disk space as an equivalent AIFF, which
is a large savings but still results in very large files compared to MP3 and AAC. Further, ALAC is not
nearly as universally accepted as AIFF.

AIFF 16-bit and AIFF 24-bit 
   AIFF 16-bit is the universal audio format on the Mac - almost every single application that deals with
audio can read AIFF files. AIFF 24-bit is a pro-audio format which is an improvement over AIFF 16-bit in
terms of quality, but takes up more hard drive space, and is much less compatible. Unless you know
that you need AIFF 24-bit, AIFF 16-bit is the recommended AIFF format.

More Information on TimersMore Information on Timers
   You can read about using Audio Hijack Pro timers in the Timers tutorial, but we've included some
additional details here.

Don't Overlap Timers 
   You can use timers for multiple Sessions that are hijacking the same application (a session for "All
Things Considered" and one for "Car Talk", both using RealPlayer, for instance). However, these timers
should not overlap. 

   In Audio Hijack Pro 2.5, we introduced Overlapping Timer detection, as well as Preemptive timers.
Audio Hijack Pro now displays a warning icon next to the Session in the Component List, as well as
highlighting the problematic Timer in the Schedule area. If these conflicts are left unresolved, the

http://lame.sourceforge.net/doc/html/modes.html
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second timer will automatically preempt the first, ending it and taking control of the Source application.

Timer Accuracy 
Timers have an accuracy of about 7 seconds, which is why we only allow timers to start on the minute.
However, if you enter a time which includes seconds, AH Pro will get as close to it as possible. For
example, enter 07:30:15 AM in the From field, and the timer will run as close to 7:30:15 AM as
possible.

Automatic Login 
With version 2.6.5, Audio Hijack Pro can even power your machine on as needed. However, you'll need
to be sure to set up Automatic Login, in the Accounts System Preference -> Login Options, in order
for Audio Hijack Pro to be able to hijack and record.

Visualize Your Timers 
   Many people wish to see a calendar of their timers, and with Audio Hijack Pro this is now possible.
From the AppleScript menu in Audio Hijack Pro, select "View timers in iCal". A new calendar called Audio
Hijack Pro will be created, providing a great way to view all your upcoming timers.

Quick RecordQuick Record
   The Quick Record feature in Audio Hijack Pro offers an easy way to hijack any application, without
setting up all the setting used in a full Session. This allows for fast, disposable hijacking. It also allows
you to hijack and record the foremost application by using the Quick Record Hot Keys.

   If you just want to make a quick recording of audio input, or only need to record from an application
once, Quick Record is just what you need. Adjust all the settings needed in one window, and don't worry
about the extra frills. Once you're done, just quit Audio Hijack Pro - next time you need to use Quick
Record, just adjust a few settings and use it again.

   To use the Quick Record Hotkeys, you'll first need to set them. Open up the Preferences window and
set the desired keys. You'll probably also want to install the Instant Hijack component - see "Install
Extras", under the "Audio Hijack Pro" menu. Once this is all done, you're ready to go. When you want to
hijack the foremost app using the settings currently in Quick Record, press the Hijack Hotkey. When you
want to hijack and record, press the Record Hotkey. Simple, fast hijacking - that's all there is to it.

Level MetersLevel Meters
   Throughout our applications, there are a variety of audio level meters. The most common of which,
are the "status" meters, which are meant to show you if things are working at a glance. The status
meters are typically in a prominent spot, the toolbar in Audio Hijack 2, the top control area in Audio
Hijack Pro 2, and the center of the Broadcast window in Nicecast. The second type of meters are
"reference" meters, meant for showing accurate readings of the audio signal level. These are in the
Effects areas of Audio Hijack Pro, and Nicecast.

   Some, but not all, of our level meters support multiple modes of operation. For meters that support it,
clicking on the meter (or the meters title bar) will present a menu of modes to choose from. The
following matrix describes the available modes: 

   Off - Turns the meters off entirely. This is useful if you are using a slower computer, or just want to
save on CPU resource usage. Most level meters can take anywhere from 1-3% of a CPU, depending on
the CPU. 

   In [RMS/Peak] - Input modes measure the raw input signal, before any processing is applied. 

   Out [RMS/Peak] - Output modes measure the level of the processed signal, after all Effects have
been applied. The Output level is the level at which the audio will be recorded/broadcasted/etc. Note
that this is before any "speaker volume/mute" adjustments are made, so Muting the speaker volume
will not affect the level the Output meters display. 

   [In/Out] RMS - RMS modes are basically the "average" signal level (really the Root-Mean-Square).
This is the most common mode for casual usage. 

   [In/Out] Peak - Peak modes show the highest signal level. They can be used to see if any distortion
in the audio is being caused by clipping.

   The reference meters feature an accurate scale (-0 dB at the top, -oo dB on the bottom) and clip
warning lights, while most status meters do not, but are fairly accurate anyway. VU Meters and MenuBar



Meters are not accurate at all, but they look the coolest (so no complaints please).

   Finally, if you need still more audio signal analysis, you can try the (built-in) "mda SpecMeter" plugin,
or download the excellent and free "Inspector" plugin from Roger Nichols Digital, at
http://www.rogernicholsdigital.com/.

Using Automator And Audio Hijack ProUsing Automator And Audio Hijack Pro
OS X 10.4 (Tiger) introduced a new feature called Automator, designed to allow automatic actions to
occur by running Automator Workflows. Audio Hijack Pro now supports using workflows for post-
processing. These can be accessed from the Recording tab for automatic post-processing and from the
Recording Bin for manual use.

Workflow Paths

Audio Hijack Pro will find workflows in the following locations: 

~/Library/Workflows/Applications/Audio Hijack Pro 
/Library/Workflows/Applications/Audio Hijack Pro 
~/Library/Application Support/Audio Hijack Pro/Recording Workflows 
/Library/Application Support/Audio Hijack Pro/Recording Workflows 
~/Library/Application Support/Audio Hijack Pro/Recording Bin Workflows 
/Library/Application Support/Audio Hijack Pro/Recording Bin Workflows

Creating Automator Workflows

As of version 2.5.1, Audio Hijack Pro can execute Automator workflows when recordings complete. With
this addition you can now easily use workflows to automate many file-related recording tasks. Examples
include copying recordings to a backup disk drive, burning MP3 CDs, adding Spotlight keywords, and
naturally all manner of iTunes related tasks.

Creating A Workflow

The following will walk you through creating a simple workflow that adds new
recording files to an iTunes playlist named "Recently Recorded". This will cover
everything you need to know about Audio Hijack Pro and Automator workflows.

1. Prerequisites

Our example workflow will add new recordings to a playlist in iTunes. So the first
thing we need to do is actually create that playlist. This should be familar enough to
most iTunes users, just open up iTunes, select "New Playlist" from the "File" menu,
and then type in the name "Recently Recorded".

2. Workflow creation

With that out of the way, we can move on to creating the actual workflow in Automator. Opening up
Automator should give you a new empty workflow with which to start. From the "Library" column, select
"iTunes", and then in the "Action" column select "Add Files to Playlist" (not "Add Songs to Playlist").
This action accepts a list of files, which it then adds to a given playlist. Drag this from the "Action"
column over into the Action area of the workflow.

http://www.rogernicholsdigital.com/
http://www.apple.com/macosx/features/automator/


Once we've added the action, all that's left to do is configure it for the desired playlist. From the
"Existing Playlist" popup, select the playlist we created above ("Recently Recorded").

Finally, we need to save the workflow. For Audio Hijack Pro to automatically see it, we need save it to
the location ~/Library/Workflows/Applications/Audio Hijack Pro (you'll need to create some of those
folders yourself).

3. Audio Hijack Pro setup

Having created the workflow, we can now tell Audio Hijack Pro to use it. Launch Audio Hijack Pro, select
the Session you want to hook the workflow up to, and click on the "Recording" tab. Next, click on the
"Scripts" popup button next to the "When Finished Recording" field. If you saved the workflow to Audio
Hijack Pro's workflow folder (see above) you'll be able to select it directly; otherwise you can "Select
Other..." to find it.

And that's it! Now whenever you record from that session, completed recordings will be added to the
"Recently Recorded" playlist in iTunes. Furthermore, your workflow is also available in the Recording Bin,
so you can apply it to already existing recordings if needed.

Scripting Audio Hijack Pro via AppleScriptScripting Audio Hijack Pro via AppleScript

Scripting via AppleScriptScripting via AppleScript

Beginning with version 2.5, Audio Hijack Pro supports a full AppleScript suite. Just about anything you
can do with the graphical user interface, you can now also script. The following is a brief overview of the
object model that Audio Hijack Pro exposes. For a complete reference, see Audio Hijack Pro's Scripting
Dictionary in Script Editor. If you are new to AppleScript, we recommend you pick up a copy of
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AppleScript : The Definitive Guide by Matt Neuburg, before proceeding.

1. Creating a session
2. Retrieving an existing session
3. Accessing audio source attributes
4. Accessing schedule and timer attributes
5. Accessing recording attributes
6. Accessing effects attributes
7. Sending commands
8. Putting it all together

Creating a sessionCreating a session

Just like in the graphical interface, the Session is the main object of interest in the scripting interface.
Unlike the graphical interface, each session in the scripting interface has a specific type: application
session, radio device session, and system audio session. As should be clear, the type of the session
specifies what kind of audio source it uses.

So, to create a new session, we use a standard AppleScript make new ... at ... statement, along with
the type of session we want to create:

set appSession to make new application session at end of sessions --For hijacking an application
set deviceSession to make new audio device session at end of sessions --For hijacking an audio device
set aSession to make new session at end of sessions --Error! The "session" class can't be instantiated!

Note that if you try to instantiate the session class (e.g. make new session), you will get an error. The
session class is an abstract base class on which the other concrete subclasses inherit from.

Retrieving an existing sessionRetrieving an existing session

Existing sessions can be accessed through the session element of the application class:

set theSession to first session whose name is "iTunes Session" --By name
set activeSessions to every session whose hijacked is true --All the active ones
set allSessions to every session --All of 'em

Accessing audio source attributesAccessing audio source attributes

Now that we have a session, we can configure its audio source. The source attributes available are
dependent on the type of the session. Application sessions have targeted application and launch
argument. Audio device sessions have input device and output device. And Radio sessions have
frequency and output device.

--Setting up an application session
tell application "Finder"
 set pathToiTunes to POSIX path of (application file id "hook" as alias)
end tell

set targeted application of appSession to pathToiTunes
set launch argument of appSession to "http://tess.fast-serv.com:8956/listen.pls"

--Setting up an audio device session
set input device of deviceSession to (first audio input whose name is "Built-in Audio: Internal microphone")
set output device of deviceSession to (first audio output whose name is "Default System Output")

Whenever files are involved, Audio Hijack Pro uses POSIX paths (/path/to/file), and not AppleScript
files or aliases (Volume:path:to:file).

Note as well, that whenever an audio device is needed, you can retrieve them from the audio input and
audio output elements of the application object:

set theNames to (name of every audio input)
set aName to first item of (choose from list theNames without multiple selections allowed)
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Accessing schedule and timer attributesAccessing schedule and timer attributes

A sessions schedule is accessible through the timer element:

set allTimers to every timer of theSession --The existing timers
set aTimer to make new timer at end of timers of theSession --Making a new one
delete the last timer of theSession --Removing an old one

The basic attributes of a timer are enabled, actions, start time and duration.

set enabled of theTimer to true --Remember to turn your timers on!
set actions of theTimer to {"record", "quit"} --Also can do "mute"

set start time of theTimer to ((current date) + (60)) --Start time is a date
set duration to 300 --5 minutes, duration is in seconds

By default, new timers are in "one-shot" mode, where they are set to fire on a specific date. To turn
them into "repeating" timers, you turn on any one of their "runs" attributes.

set {runs Monday, runs Wednesday, runs Friday} to {true, true, true} --MWF

Accessing recording attributesAccessing recording attributes

Most of Audio Hijack Pro's recording settings are simple attributes of the session:

--Set some Tags
set title tag of theSession to "80s Airwaves"
set genre tag of theSession to "80s"

--And some file settings
set output folder of theSession to "~/Music" --This is a POSIX path
set output name format of theSession to "%tag_title %date"

The recording format, file size limit, and recording time limit attributes are a bit more complex, as they
are represented by a special class (audio recording format and size or length limit).

set recording format of theSession to {encoding:AAC, bit rate:128, channels:Stereo, style:Bookmarkable} --Record to a Bookmarkable AAC
set recording format of theSession to {encoding:MP3, bit rate:192, channels:Stereo, style:VBR} --Record to a VBR MP3
set file size limit of theSession to {enabled:yes, unit:MB, value:650} --Split every 650MB

Accessing effects attributesAccessing effects attributes

Currently, the Effects system can not be directly accessed via AppleScript. If you'd like this in a future
version, please contact us at audiohijackpro@rogueamoeba.com

Sending commandsSending commands

Finally, there are the commands for hijacking:

start hijacking theSession
start hijacking theSession relaunch yes --Avoids the relaunch alert
stop hijacking theSession

And recording:

start recording theSession
stop recording theSession
split recording theSession

pause recording theSession
unpause recording theSession

mailto:audiohijackpro@rogueamoeba.com


Putting it all  togetherPutting it all  together

A complete example script that shows how to put all these basic pieces together into one script, is
available at: http://rogueamoeba.com/audiohijackpro/scripting/downloads/BasicExample.scpt

Extending Audio Hijack Pro via AppleScriptExtending Audio Hijack Pro via AppleScript
Extending via AppleScripts 
   In addition to being scripted, Audio Hijack Pro can be extended via "plugin" style AppleScripts. It
supports these plugin scripts in three flavors: 
(1) Source Target AppleScripts which dynamically generate URLs to be record, 
(2) Post-processing AppleScripts which process recording files as they are made 
(3) Recording Bin AppleScripts which process recording files after they are made.

Source Target AppleScripts 
   Source Target AppleScripts can be used when you need to hijack URLs that change often and in
predictable ways. They generate a URL string, and return it back to Audio Hijack Pro. 

   Here is an example Source Target AppleScript that generates URLs like "http://example.com/program-
2004-10-03.ram":

set urlString to "http://example.com/program-%Y-%m-%d.ram"
set urlString to do shell script "echo -n; date '+" & urlString & "'"
return urlString

   Note that "do shell script" may fail in Audio Hijack Pro (the hijacker breaks it). The work around is to
prefix the command string with "echo -n;" (as in the example above).

Post-processing AppleScripts 
   Post-processing scripts let you process recording files immediately after they are completed. As Audio
Hijack Pro finishes a session, it will pass a list of recording files to the "process" subroutine in the given
post-processing AppleScript. 

   The "process" subrountine takes a single arguement, a list of files. 

   Note that post-processing scripts are invoked batch-style, with all recordings being handed off at
once, and not one at a time (as was previously the case in older versions of Audio Hijack Pro). 

   Here is an example post-processing script that adds files to iTunes library:

on process(theArgs)
 
 --Into iTunes ye files shall go
 tell application "iTunes"
  repeat with theFile in theArgs
   add theFile
  end repeat
 end tell
 
end process

   To have Post-processing AppleScripts show up in the Recording script list, place them in:
~/Library/Application Support/Audio Hijack Pro/Recording Scripts.

Recording Bin Applecripts 
   Recording Bin AppleScripts are almost exactly the same as Post-processing AppleScripts, except they
run only when selected manually, and the argument passed to the "process" subroutine is always a list
of files. Any correctly written Post-processing script can effectively function as both a Post-processing
script and a Recording Bin script. 

   To have Recording Bin AppleScripts show up in the Recording Bin's script list, place them in:
~/Library/Application Support/Audio Hijack Pro/Recording Bin Scripts.

Credits, Licenses, Contacts and All  The Fun That InvolvesCredits, Licenses, Contacts and All  The Fun That Involves
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   We now present the conclusion to the Audio Hijack Pro Manual, on the Rogue Amoeba Tuesday
Morning Movie. 

-User License - Let your lawyer explain it all to you. 

-Licensing - Information about licensing the technology Audio Hijack Pro is built on. 

-Contact - How to get in touch with Rogue Amoeba. 

-Acknowledgements - We couldn't have done it without them. 

-Printable Manual - A link to the printable version of this manual. 

Audio Hijack Pro - Your Ears Will Thank You
LicenseLicense

DistributionDistribution 
Unless explicitly stated in writing, Rogue Amoeba Software does not grant permission to sell Audio
Hijack Pro ("The Software"). Non-profit distribution of The Software in its trial form is acceptable
provided that The Software is not modified in any way, and the complete works of The Software are
included in the distribution package. If The Software is to be included in a distribution package, Rogue
Amoeba requests but does not require that one complimentary copy of said package, sent to the
following address:

Rogue Amoeba Software 
25 Wheeler St. #314 
Cambridge, MA 02138

What that said: Don't sell this software directly for profit. If you want to distribute it, great! Just make
sure it's unmodified from the download from our site. If you create a distribution package, it'd be cool if
you sent a copy to the address above, though this is not required.

RefundsRefunds 
All Rogue Amoeba products are available as demos for an evaluation prior to purchase. We believe that
no customer should have to buy software in order to find out how well it works. Our software can be
fully evaluated with no limitations in capabilities, prior to purchase. Customers are strongly
encouraged to take advantage of these trials prior to purchase. You may also seek any needed
technical support from us - we answer support emails rapidly and responsively for current and potential
customers alike. 

If you would like a refund, please contact hello@rogueamoeba.com within 14 days of your purchase.
Because we can not recover the license key that was sold, refunds are issued on a case-by-case basis. 

What that said: We want you to be happy, so we enable you to test drive our software. If you have
any questions, let us know before you buy, we're happy to help. Refunds may be issued within 14 days
of purchase, at our discretion.

DisclaimerDisclaimer 
Audio Hijack Pro ("The Software") is provided as is. Rogue Amoeba Software ("The Author") is not
responsible for any damage to the user's computer system or data and in no event will The Author, its
officers, directors, employees or agents be responsible to the user for any consequential, incidental, or
indirect damages (including damages for loss of business profits, business interruption, loss of business
information, and the like) arising out of the use or inability to use the The Software, even if The Author
has been advised of the possibility of such damages. Because some states do not allow the exclusion or
limitation of liability for consequential or incidental damages, the above limitations may not apply to
you. Further, the consumer agrees that using this software in any way illegal, or even for the purposes
of assessing its viability for illegal usage, is prohibited. 

What that said: Be safe when you use the software. Be aware that it's simply a tool designed to make
your life better. Don't use it to do illegal or evil things. If you do, be ready to take responsibility for
your own actions.

LicensingLicensing
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Audio Hijack TechnologyAudio Hijack Technology 
Audio Hijack Pro is built on Audio Hijack technology, the same technology powering many of our
products. We have several technologies that have been adapted for licensing. For more details, see our
online licensing page. 

ContactsContacts
Audio Hijack Pro Homepage 
http://www.rogueamoeba.com/audiohijackpro 

Rogue Amoeba Homepage 
http://www.rogueamoeba.com 

Buying Audio Hijack Pro 
Visit our online store or see Purchasing 

Audio Hijack Pro Support: 
audiohijackpro@rogueamoeba.com Be sure to look over the Known Issues page, and the support center
first. 

Join the Rogue Amoeba low-traffic announcement list. There's no spam, EVER. It's as simple as that. 
http://www.rogueamoeba.com/company/lists/maclist.php

Printable ManualPrintable Manual

 
To print this entire manual, download the PDF version here.

AppendixAppendix
   The following pages contain additional information that may prove useful to some users. It is not,
however, required or even recommended reading, and thus it has been placed at the end of this
manual. 

Audio Effects - Contains a very basic overview of the audio effects included with Audio Hijack Pro

Full Plugin Descriptions

About

This product uses Rogue Amoeba's SW4FX plugin architecture to provide Effects. These effects range
from Equalizers to VoiceOver plugins. SW4FX works with Rogue Amoeba's own 4FX plugin format, as
well as industry-standard AudioUnit and VST plugins. SW4FX now also features preliminary support for
VSTi and AU synths. Read on for more details on each plugin. 

For information on licensing the SW4FX system for your audio application, see our Licensing page.

4fx Plugins

10-Band Equalizer - The Equalizer amplifies or de-amplifies different frequencies to allow for precise
audio tuning. Each bar can be adjusted to edit one band of the EQ, or presets may be chosen from the
menu. If a custom preset is created, it may be also saved. 
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Application Mixer - Application Mixer enables audio from applications other than the Source to be
mixed in to the audio. This is useful for mixing multiple applications into a single audio stream. 

Auxiliary Device Output - The Auxiliary Device Output plugin sends the audio stream being hijacked to
the specified output device. This can be useful for sending audio to multiple devices, as well as causing
the application responsible for the hijacking to actually output audio (for instance, to hijack Nicecast
with Audio Hijack Pro, or to transmit Audio Hijack Pro with Airfoil). 

Balance - Balance alters the playback of each channel, through each of your speakers. For example, if
you put balance to the far left, you'll hear only the left channel of audio, from the left speaker. 

Bass And Treble - Bass And Treble affects the bass and treble for all output. 

Channel Tweaker - Channel Tweaker adjusts the output of the two channels. The included options are
as follows: 

Swap Channels - Reverse the Right and Left channel output 

Monomize - Converts a Stereo signal to Mono 

Duplicate Left - Duplicates the Left channel into the Right channel 

Duplicate Right - Duplicates the Right channel into the Left channel 

Kill Left - Removes the Left channel 

Kill Right - Removes the Right channel 

Double Gain - Double Gain doubles the gain set in the Gain plugin. Use this plugin to overdrive your
sound. 

Gain - Gain can be used to quickly lower the gain. 

Karaoke - Karaoke uses a simple (read: not always successful) algorithm to remove the vocals on
songs. 

Low Pass Filter - The Low Pass Filter increases the sound quality of lower quality recordings, including
low bitrate radio streams. 

Menu Bar Meters - Evilly Cool Menu Bar VU meters or Level meters. Kick Ass! 

Mono Enhancer - The Mono Enhancer enhances the sound of audio encoded in mono to give it a stereo
sound. 

Monomizer - The Monomizer downmixes the sound of audio encoded in stereo channels into one mono
channel. In this way, no audio is lost. This is very useful for broadcasting a mono stream. 

Pan - Pan alters the balance of the left and right audio signals, shifting them from one side to the
other. For example, if you set Pan to the far left, you'll hear both stereo channels out of your left
speaker only. 

PassThru - PassThru produces absolutely no audio effect. It will provide a quick pair of Gain knobs as
needed, and can also be useful for advanced audio routing. 

Pipe Dream - Pipes audio to command-line applications. Use with encoders or broadcasting servers
such as icecast. 

Reverb - Reverb alters the output, depending on user-defined settings, to create a live reverberated
sound in the audio. 

Side Chain Limiter (SCL) - The Side Chain Limiter, when used in a pair, will allow plugins to adjust
audio without radically affecting its gain. Place one SCL plugin at the front of a plugin chain in Send
mode, and one at the end in Receive mode, and the volume over that section will be roughly equalized,
preventing dramatic adjustments. The Band allows for up to 10 different buses of audio, while the
Reduction Level item acts as a level meter, displaying the work the SCLs are doing. 



Swap Channels - Swap Channels swaps the output of the left and right audio channels. 

Voiceover - Voiceover allows you to mix audio from your sound input source (usually a microphone)
into your current audio. This is most useful for DJing a stream, allowing you to create a professional
quality sound. 

VU Meters - An optionally floating VU Meters window, responding to audio.

AudioUnit Plugins

The Audio Units you see inside of Nicecast are actually built in to the operating system by Apple. The
following basic overviews should help you get started. 

AUAudioFilePlayer - This plugin plays back audio files, including MP3, AAC, Apple Lossless and AIFF
files. This plugin is a great addition for both broadcaster and podcaster, as it allows for audio such as
intro music, outro music and sound clips in it to be queued up. With one click, the audio can then be
played. It also has "region" support, a small part of a larger file can be set to play.(OS X 10.4 and up
only) 

AUBandPass - "Band Pass" refers to frequencies within a certain band (or range) being passed
through, while others are blocked or de-emphasized. This allows an emphasis on high, mid or low range
frequencies, for different sounds. The center frequency control adjusts the center point of the band of
emphasized frequencies, while the bandwidth control adjusts the size of the band. 

AUDelay - This will add repeats to audio, creating an echo. The mix of original source to echo can be
adjusted with the dry/wet control, the delay control sets the gap between repeats, feedback controls the
number of repetitions, and the lowpass cutoff frequency does just that, cutting out certain frequencies. 

AUDynamicsProcessor - A dynamics processor alters an audio signal based on its frequency content
and amplitude level. This includes compressors and expanders. The factory presets for this plugin will
work well, and as will experimentation with the more complicated settings. 

AUFilter - AUFilter is a combination of a Low Shelf/High Pass filter and a High Shelf/Low Pass filter. See
AUHiPass and AULowpass(OS X 10.4 and up only) 

AUGraphicEQ - This is a standard EQ, with a range from 20 Hz to 20,000 Hz, allowing the center
frequency for each band to be set. However, this EQ divides that frequency range into 31 different
bands, allowing for more precise the adjustments. 

AUHighShelfFilter - This plugin works much like the AUBandpass filter. However, it allows low
frequencies to pass, and drastically cuts off high frequencies ("shelving" them). The cutoff frequency
sets where the shelf is, and the gain setting adjusts the boosting or cutting of the frequency's upper
end volume. 

AUHiPass - This filter reduces low frequencies and passes high frequencies through. It will reduce low
rumbles in audio, for example from engines or air conditioner units. The settings allow for adjusting
where exactly the cutoff occurs. 

AULowPass - This is the opposite of the AUHiPass filter, reducing high frequencies and passing through
low ones. This too can eliminate undesired noise, specifically high-pitched noises such as tape hiss and
machine noise. It can also improve the quality on low-end microphones. Again, the settings allow for
adjusting where exactly the cutoff occurs. 

AULowShelfFilter - This plugin is the opposite of the AUHighShelfFilter, but again works much like
AUBandPass. It allows high frequencies to pass, and drastically cuts off low frequencies. It can be used,
like the AUHiPass, for dealing with low frequency rumbles. The cutoff frequency again sets where the
shelf is, and the gain setting adjusts the boosting or cutting of the frequency's upper end volume. 

AUMatrixReverb - This plugin can create a wide range of reverb effects. The best bet with this is to
experiment, as there are many controls, and many different reverbs can be obtained. One tip to note,
to obtain more pronounced reverb effects, set control sliders higher. 

AUMultibandCompressor - A compressor will reduce the range of your audio signal, compressing the
high and low ends towards the middle. This particular compressor allows compression on multiple bands,



through complicated controls. Again, experimentation will help here, as well as using the preset controls
for this plugin. 

AUNetReceive - AUNetReceive works in a pair with AUNetSend to receive audio from one location to
another. AUNetReceive finds AUNetSend transmissions over Bonjour and inserts the audio into the
stream.(OS X 10.4 and up only) 

AUNetSend - AUNetSend works in a pair with AUNetReceive to send audio from one location to
another. AUNetSend can send this audio in a variety of formats: uncompressed AIFF, Apple Lossless,
compressed AIFF, and AAC. On a fast network or between two applications, sending via Apple Lossless
is your best bet. Otherwise you can drop down to a high-bitate AAC to save on bandwidth (but with a
CPU hit). (OS X 10.4 and up only) 

AUParametricEQ - The parametric EQ simply allows a signal's amplitude to be boosted or dropped in a
given frequency range. It works like a one band EQ, with an adjustable Quality Of Filter (Q). 

AUPeakLimiter - The peak limiter smoothes the volume on all frequencies, compressing the volume
and reducing the dynamic range to prevent volume increases. The attack and decay settings specify
how quick the volume level is adjusted following a change in levels. 

AUPitch - AUPitch is a "Pitch And Speed" plugin (pictured right), with 24 different parameters. The first
setting, Pitch, is the most important and will enable the adjustment of the pitch of incoming audio. (OS
X 10.4 and up only) 

AUSampleDelay - AUSampleDelay is similar to AUDelay, in that it buffers audio to add a delay. The
difference between the two is that with AUDelay, the delay time is set as a number of seconds, while
AUSampleDelay sets the delay time as a count of audio samples. Most people will want AUDelay, as
AUSampleDelay is really only useful when doing sample-accurate audio work. (OS X 10.4 and up only) 

AuScheduledSoundPlayer - Unknown. (OS X 10.4 and up only)

VST Plugins

The included VST plugins come courtesy of mda and Green Oak, and Rogue Amoeba is much obliged to
these companies. For more information, please see mda-vst.com and greenoak.com

LADSPA PluginsLADSPA Plugins 
Audio Hijack Pro is one of the first applications on OS X to support the Linux Audio Developer's Simple
Plugin API (LADSPA) plugin format. The included LADSPA plugins are detailed below. More information is
available from http://plugin.org.uk/. The text below is taken from Steve Harris' LADSPA Plugin Docs. 

Declipper 
Removes nasty clicks from input signals, not very kind to them though. 

DJ EQ 
The design for this plugin is taken from the Allen & Heath Xone 32 DJ mixer. 

Lo gain (dB) - Controls the gain of the low (100Hz) peak/dip band 

Mid gain (dB) - Controls the gain of the mid (1000Hz) peak/dip band 

Hi gain (dB) - Controls the gain of the high (10000Hz) shelf band 

DJ Flanger 
This is a flanger which is more or less typical of DJ mixing desks. 

LFO sync - When turned from off to on it resets the phase of the LFO back to the start of the cycle.
Used to sync the LFO to the track. 

LFO period (s) - The cycle period of the LFO in seconds. 

LFO depth (ms) - The maximum delay the LFO will use to flange, in milliseconds. 

L/C/R Delay 
This is a left/centre/right delay with feedback, based on the one in the Korg Trinity. Requested by Marek

http://www.mda-vst.com/vst/help/contents.htm
http://www.greenoak.com/vst.html
http://plugin.org.uk/
http://plugin.org.uk/ladspa-swh/docs/ladspa-swh.html


Peteraj. 

L delay (ms) - The delay of the left output in milliseconds. 

L level - The level of the left output. 

C delay (ms) - The delay of the centre output in milliseconds. 

C level - The level of the centre output. 

R delay (ms) - The delay of the right output in milliseconds. 

R level - The level of the right output. 

Feedback - The amount of the C delay output that is mixed back into the delay. 

High damp (%) - The damping of the high frequencies in the feedback path. 

Low damp (%) - The damping of the low frequencies in the feedback path. 

Spread - The width of the stereo image. 

Dry/Wet level - The amounts of the input and effect mixed to produce the output. 

VyNil (Vinyl Effect) 

Year - The date of the recording/playback equipment to be simulated. 

RPM - The rotational speed of the platter. 

Surface warping - The degree of variation in height of the record surface. 

Crackle - The number of scratches on the record surface. 

Wear - The amount of wear on the grooves.


